<table>
<thead>
<tr>
<th>Contents</th>
<th>Index</th>
<th>How to Use This Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td></td>
<td>ScandAll PRO V2.0 User's Guide</td>
</tr>
<tr>
<td>Conventions</td>
<td></td>
<td>Explains about ScandAll PRO.</td>
</tr>
<tr>
<td>Prior to Use</td>
<td></td>
<td>Explains how to scan documents using ScandAll PRO.</td>
</tr>
<tr>
<td>Scanning with ScandAll PRO</td>
<td></td>
<td>ScandAll PRO V2.0 User's Guide</td>
</tr>
</tbody>
</table>
How to Use This Manual

The following shows the tips for using this manual.

- To display or print this manual, either Adobe® Acrobat® (7.0 or later) or Adobe Reader® (7.0 or later) is required.
- You can use the Adobe® Acrobat® or Adobe Reader® Search tool to search this manual. For details, refer to Adobe® Acrobat® or Adobe Reader® Help.
- Use the [Page Up] key to return to the previous page, and the [Page Down] key to go to the next page.
- Click a blue character string, tab or contents/index title (where the mouse cursor changes into a shape such as 🦇) to jump to the link.

Common for all pages

Jumps to the first page of each chapter. These tabs are on every page.

Click on a title to jump to the link.

Click on a page number to jump to the link.
Thank you for using ScandAll PRO.
The contents of this manual may be changed following updates of ScandAll PRO.
The latest version of the ScandAll PRO User’s Guide is available from the Web site below. An Internet connection is required for downloading.

About This Product

ScandAll PRO is an application that enables you to display and edit images scanned with an fi-Series color image scanner.
This manual describes how to use ScandAll PRO for scanning with an fi-Series color image scanner.
For details about the functions of ScandAll PRO, refer to the ScandAll PRO Help.

Trademarks

Microsoft, Windows, Windows Server, Windows Vista, Excel, PowerPoint and SharePoint are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
Word is the product of Microsoft Corporation in the United States.
ISIS is a registered trademark of EMC Corporation in the United States.
Adobe, the Adobe logo, Acrobat, and Adobe Reader are either registered trademarks or trade names of Adobe Systems Incorporated in the United States and/or other countries.
Intel and Intel Core are trademarks or registered trademarks of Intel Corporation in the United States and other countries.
ABBYY™ FineReader™ Engine ©2011 ABBYY. OCR by ABBYY
ABBYY and FineReader are trademarks of ABBYY.
Kofax and VRS are trademarks or registered trademarks of Kofax, Inc.
QR Code is registered trademark of DENSO WAVE INCORPORATED in JAPAN and other countries.
Other company names and product names are the registered trademarks or trademarks of the respective companies.

Manufacturer

PFU LIMITED
International Sales Dept., Imaging Business Division, Products Group
Solid Square East Tower, 580 Horikawa-cho, Saiwai-ku, Kawasaki-shi Kanagawa 212-8563, JAPAN.
Phone: (81-44) 540-4538
© PFU LIMITED 2011-2012
Use in High-Safety Applications

This product has been designed and manufactured on the assumption that it will be used in office, personal, domestic, regular industrial, and general purpose applications. It has not been designed and manufactured for use in applications (simply called “high-safety applications” from here on) that directly involve danger to life and health when a high degree of safety is required, for example, in the control of nuclear reactions at nuclear power facilities, automatic flight control of aircraft, air traffic control, operation control in mass-transport systems, medical equipment for sustaining life, and missile firing control in weapons systems, and when provisionally the safety in question is not ensured. The user should use this product with adopting measures for ensuring safety in such high-safety applications. PFU LIMITED assumes no liability whatsoever for damages arising from use of this product by the user in high-safety applications, and for any claims or compensation for damages by the user or a third party.
# Conventions

## Symbols Used in This Manual

In this manual, the following symbols are used to describe operations.

![This symbol alerts operators to particularly important information. Be sure to read this information.]

![This symbol alerts operators to helpful advice regarding operation.]

## Abbreviations Used in This Manual

The following abbreviations are used in this manual:

<table>
<thead>
<tr>
<th>Product</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Windows® XP Home Edition</td>
<td>Windows XP (*1)</td>
</tr>
<tr>
<td>● Windows® XP Professional</td>
<td></td>
</tr>
<tr>
<td>● Windows® XP Professional x64 Edition</td>
<td></td>
</tr>
<tr>
<td>● Windows Server® 2003 R2, Standard x64 Edition</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Home Premium (32/64-bit)</td>
<td>Windows 7 (*1)</td>
</tr>
<tr>
<td>● Windows® 7 Professional (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Server® 2008 R2 Standard (64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Home Basic (32/64-bit)</td>
<td>Windows Vista (*1)</td>
</tr>
<tr>
<td>● Windows Vista® Home Premium (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Business (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Business (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Home Premium (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Home Basic (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Business (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Home Basic (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Home Premium (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Business (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Business (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Home Premium (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Home Basic (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Business (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Home Basic (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Home Premium (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Business (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Vista® Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Server® 2008 R2 Standard (64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Home Premium (32/64-bit)</td>
<td>Windows 7 (*1)</td>
</tr>
<tr>
<td>● Windows® 7 Professional (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Server® 2008 R2 Standard (64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Home Premium (32/64-bit)</td>
<td>Windows 7 (*1)</td>
</tr>
<tr>
<td>● Windows® 7 Professional (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Server® 2008 R2 Standard (64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Home Premium (32/64-bit)</td>
<td>Windows 7 (*1)</td>
</tr>
<tr>
<td>● Windows® 7 Professional (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Server® 2008 R2 Standard (64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Home Premium (32/64-bit)</td>
<td>Windows 7 (*1)</td>
</tr>
<tr>
<td>● Windows® 7 Professional (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Server® 2008 R2 Standard (64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Home Premium (32/64-bit)</td>
<td>Windows 7 (*1)</td>
</tr>
<tr>
<td>● Windows® 7 Professional (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Server® 2008 R2 Standard (64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Home Premium (32/64-bit)</td>
<td>Windows 7 (*1)</td>
</tr>
<tr>
<td>● Windows® 7 Professional (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Server® 2008 R2 Standard (64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Home Premium (32/64-bit)</td>
<td>Windows 7 (*1)</td>
</tr>
<tr>
<td>● Windows® 7 Professional (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows Server® 2008 R2 Standard (64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Home Premium (32/64-bit)</td>
<td>Windows 7 (*1)</td>
</tr>
<tr>
<td>● Windows® 7 Professional (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>● Windows® 7 Ultimate (32/64-bit)</td>
<td></td>
</tr>
</tbody>
</table>
### Product Indication

<table>
<thead>
<tr>
<th>Product</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Microsoft® Office SharePoint® Portal Server 2003</td>
<td>SharePoint Server</td>
</tr>
<tr>
<td>● Microsoft® Office SharePoint® Server 2007</td>
<td>SharePoint</td>
</tr>
<tr>
<td>● Microsoft® SharePoint® Server 2010</td>
<td>SharePoint</td>
</tr>
<tr>
<td>● Microsoft® Windows® SharePoint® Services 2.0 / 3.0</td>
<td>SharePoint</td>
</tr>
<tr>
<td>● Microsoft® SharePoint® Foundation 2010</td>
<td>SharePoint</td>
</tr>
<tr>
<td>● Microsoft® Office Word 2002</td>
<td>Word</td>
</tr>
<tr>
<td>● Microsoft® Office Word 2003</td>
<td>Word</td>
</tr>
<tr>
<td>● Microsoft® Office Word 2007</td>
<td>Word</td>
</tr>
<tr>
<td>● Microsoft® Word 2010</td>
<td>Word</td>
</tr>
<tr>
<td>● Microsoft® Office Excel® 2002</td>
<td>Excel</td>
</tr>
<tr>
<td>● Microsoft® Office Excel® 2003</td>
<td>Excel</td>
</tr>
<tr>
<td>● Microsoft® Office Excel® 2007</td>
<td>Excel</td>
</tr>
<tr>
<td>● Microsoft Excel® 2010</td>
<td>Excel</td>
</tr>
<tr>
<td>● Microsoft® Office PowerPoint® 2002</td>
<td>PowerPoint</td>
</tr>
<tr>
<td>● Microsoft® Office PowerPoint® 2003</td>
<td>PowerPoint</td>
</tr>
<tr>
<td>● Microsoft® Office PowerPoint® 2007</td>
<td>PowerPoint</td>
</tr>
<tr>
<td>● Microsoft® PowerPoint® 2010</td>
<td>PowerPoint</td>
</tr>
<tr>
<td>Adobe® Acrobat®</td>
<td>Adobe Acrobat</td>
</tr>
<tr>
<td>Adobe Reader®</td>
<td>Adobe Reader</td>
</tr>
<tr>
<td>ABBYY FineReader for ScanSnap™</td>
<td>ABBYY FineReader for ScanSnap</td>
</tr>
</tbody>
</table>

### Product Indication

<table>
<thead>
<tr>
<th>Product</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScandAll PRO ScanSnap mode Add-in</td>
<td>ScanSnap mode</td>
</tr>
</tbody>
</table>

*1*: Where there is no distinction between the different versions of the above operating system, the general term "Windows" is used.

### Arrow Symbols in This Manual

Right-arrow symbols (→) are used to separate icons or menu options you should select in succession.

Example: Click the [Scan] menu → [Scanner Setting].

### Screen Examples in This Manual

The screen examples in this manual are subject to change without notice in the interest of product improvement.

If the actual displayed screen differs from the screen examples in this manual, operate by following the actual displayed screen while referring to the user's manual of the scanner application you are using. The screen examples used in this manual are of the TWAIN driver, ISIS driver, and ScandAll PRO (image scanning application).

This manual uses screenshots from Windows Vista. The windows that appear and the operations differ by the operating system that you are using. Also note that with some scanner models, the screens and operations may differ from this manual when you update the TWAIN driver or the ISIS driver. In this case, refer to the manual provided upon updating the driver.

### Scanner Component Names in This Manual

The button names on the scanner and the name of the display area of the operation panel described in this manual may differ depending on the scanner you are using.

In this case, refer to the Operator's Guide for your scanner.
Contents

How to Use This Manual ................................................................................................................................. 2

Introduction ..................................................................................................................................................... 3

About This Product ........................................................................................................................................ 3
Trademarks .................................................................................................................................................. 3
Manufacturer ................................................................................................................................................ 3
Use in High-Safety Applications ........................................................................................................................ 4

Conventions .................................................................................................................................................... 5

Symbols Used in This Manual .......................................................................................................................... 5
Abbreviations Used in This Manual ................................................................................................................... 5
Arrow Symbols in This Manual ......................................................................................................................... 6
Screen Examples in This Manual ...................................................................................................................... 6
Scanner Component Names in This Manual ....................................................................................................... 6

Chapter 1 Prior to Use ................................................................................................................................... 10

1.1 Overview .............................................................................................................................................. 11
1.2 Features ............................................................................................................................................... 12
   ScandAll PRO ................................................................................................................................... 12
   ScanSnap mode ................................................................................................................................ 13
1.3 System Requirements ............................................................................................................................. 14
   System Requirements ................................................................................................................................. 14
   Supported Models ................................................................................................................................... 15
1.4 Launching ............................................................................................................................................. 16
   ScandAll PRO ................................................................................................................................... 16
Chapter 1 Prior to Use

This chapter describes the overview, features and starting procedures of ScandAll PRO.

1.1 Overview ....................................................................................................................................................... 11
1.2 Features ........................................................................................................................................................ 12
1.3 System Requirements ...................................................................................................................................... 14
1.4 Launching ...................................................................................................................................................... 16
1.1 Overview

ScandAll PRO is an image scanning application, which conforms with both TWAIN/ISIS standards. ScandAll PRO can scan documents to make image data.

ScanSnap mode, an application for additional functions, can be installed when ScandAll PRO is installed.
By installing ScanSnap mode, you can scan images in two ways by using ScandAll PRO or ScanSnap mode.

- **ScandAll PRO**
  Configured for a TWAIN driver, ISIS driver or Kofax VRS (*1), ScandAll PRO allows you to scan a document to make image data. A TWAIN driver, ISIS driver or Kofax VRS is required for scanning.
  You can save the scan settings as profiles and perform a scan based on your business.
  ScandAll PRO is suitable for digitalizing paper documents for routine work, such as business or application forms. (For corporate use)

- **ScanSnap mode**
  Configured for a scanner driver, ScanSnap mode allows you to scan a document to make image data. A TWAIN driver is required for scanning.
  You can save the scanned images as PDF or JPEG files with a single press of the [Scan] button on the scanner, without configuring any particular settings.
  It provides a post-scan choice where you select an application from the "Quick Menu" which appears after scanning, and then perform tasks such as creating image data, or sending/printing the scanned images. (For personal use)

*1 : An application that can easily be used to create high-quality images. VRS can also detect and automatically correct errors that may occur while scanning. For example, VRS corrects skewed or smudged characters due to the colored or shaded effects.
Kofax VRS can be used for scanners that support Kofax VRS.

- For details about the functions of ScandAll PRO, refer to the ScandAll PRO Help.
- For details about the functions of ScanSnap mode, refer to the ScanSnap mode Help.
- For details about the supported models of ScanSnap mode, refer to the ScandAll PRO ScanSnap mode Add-in V1.0 User's Guide.
  When ScandAll PRO ScanSnap mode Add-in V1.0 User's Guide is not included in the Setup DVD-ROM, you can download it from the Web site below. An Internet connection is required for downloading.
1.2 Features

ScandAll PRO

ScandAll PRO has the following features:

Various Scan Settings

- Allows batch processing (batch scan), enabling scan operations with scan conditions, file format, and file save destination specified. You can also save the specified scan settings as a profile.
- Allows scan operations with a single touch on a keyboard according to specified hot key controls.
- Allows you to set events, enabling batch scans with a single press of the [Scan] button or [Send to] button on the scanner.

Display/Edit/Save Functions to Meet Your Needs

- Shows multiple files side-by-side, which allows the files to be compared easily.
- Allows editing scanned images. You can overwrite the data, or save the edited data with a different file name or in a different file format than those used at the time of scanning. (An edited PDF file cannot be saved in a different file format)
- Outputs both color/monochrome images simultaneously with a single scan. (When using a scanner that supports the multi-image output function.)
- Imports/outputs BMP, JPEG, JPEG2000, TIFF, PDF and PDF/A files. PDF and PDF/A files can also be outputted as searchable PDF files and high-compression PDF files.

Other Useful Functions

- Automatically saves the scanned images in the specified server by linking with FTP server or SharePoint.
- Sends the scanned images as an attached file by linking with an e-mail program.
- Classifies pages of a document in a specified unit and saves them in separate files by using patch codes or barcodes.
- Performs barcode recognition, or character recognition with Zone OCR, over the scanned images. Both functions can output the recognition results to the indexing information file and the results can be used as file names of the scanned images.
- Launches the specified application while using the output image file or indexing information file as a parameter.
- Checks for errors in the scanned images, and if any exist, changes the background color of the target thumbnail (fi-6800 only).
- Marks thumbnails of the scanned images by changing the background color so that they can be easily sorted.
- Imports and exports profiles to apply the same ScandAll PRO settings to ScandAll PRO in another computer. This function can be useful when you want to apply the same settings to multiple computers, because you only need to import the profile without configuring them for each computer.
ScanSnap mode

ScanSnap mode has the following features:

- Outputs the scanned images as PDF or JPEG files with a single press of the [Scan] button on the scanner. You can scan long pages by pressing the [Send to] button on the scanner.
- Sends the scanned image and the save directory information by sending an e-mail or printing.
- Monitors the scanner status and indicates whether the scanner can be used with the icon on the taskbar.
- Converts the scanned images into the following types of files by using ABBYY FineReader for ScanSnap. ABBYY FineReader for ScanSnap can be installed at the same time as ScanSnap mode.
  - Word
  - Excel
  - PowerPoint
- Automatically saves the scanned images in the specified server by linking with SharePoint.
- Allows editing scanned images (PDF files). You can overwrite the data, or save the edited data under a different file name.
### 1.3 System Requirements

#### System Requirements

ScandAll PRO including ScanSnap mode has the following system requirements:

<table>
<thead>
<tr>
<th>Operating system (*1)</th>
<th>Windows® XP Home Edition (Service Pack 3 or later)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows® XP Professional (Service Pack 3 or later)</td>
</tr>
<tr>
<td></td>
<td>Windows® XP Professional x64 Edition (Service Pack 2 or later)</td>
</tr>
<tr>
<td></td>
<td>Windows Server® 2003 R2, Standard Edition (Service Pack 2 or later)</td>
</tr>
<tr>
<td></td>
<td>Windows Server® 2003 R2, Standard x64 Edition (Service Pack 2 or later)</td>
</tr>
<tr>
<td></td>
<td>Windows Vista® Home Basic (32/64-bit) (Service Pack 1 or later)</td>
</tr>
<tr>
<td></td>
<td>Windows Vista® Home Premium (32/64-bit) (Service Pack 1 or later)</td>
</tr>
<tr>
<td></td>
<td>Windows Vista® Business (32/64-bit) (Service Pack 1 or later)</td>
</tr>
<tr>
<td></td>
<td>Windows Vista® Enterprise (32/64-bit) (Service Pack 1 or later)</td>
</tr>
<tr>
<td></td>
<td>Windows Vista® Ultimate (32/64-bit) (Service Pack 1 or later)</td>
</tr>
<tr>
<td></td>
<td>Windows Server® 2008 Standard (32/64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows Server® 2008 R2 Standard (64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows® 7 Home Premium (32/64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows® 7 Professional (32/64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows® 7 Enterprise (32/64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows® 7 Ultimate (32/64-bit)</td>
</tr>
</tbody>
</table>

| CPU                   | Intel® Core™ 2 Duo 2.2 GHz or higher recommended |

| Memory                | 2 GB or more recommended |
| Display resoultion (*2) | 1024 × 768 pixels or more, and 65536 colors or more |
| Disk space            | 1.3 GB or more of free space (*3) |

*1: ScandAll PRO is supported as a 32-bit application which can operate on a 64-bit operating system.

*2: When the font size is too large, some screens may not be shown correctly. In this case, decrease the font size.

*3: Required disk space varies according to the file size of the scanned images.
**Supported Models**

**ScandAll PRO**
ScandAll PRO supports the fi-Series color image scanner.

⚠️ **fi-60F is not supported.**

**ScanSnap mode**
For details about the supported models of ScanSnap mode, refer to ScandAll PRO ScanSnap mode Add-in V1.0 User's Guide.

✔️ When ScandAll PRO ScanSnap mode Add-in V1.0 User's Guide is not included in the Setup DVD-ROM, you can download it from the Web site below. An Internet connection is required for downloading.

1.4 Launching

ScandAll PRO

The procedure to start ScandAll PRO is as follows:

1. Select the [Start] menu → [All Programs] → [Fujitsu ScandAll PRO] → [ScandAll PRO].
   
   $\Rightarrow$ ScandAll PRO starts up.

For how to start ScanSnap mode, refer to the ScandAll PRO ScanSnap mode Add-in V1.0 User's Guide. When ScandAll PRO ScanSnap mode Add-in V1.0 User's Guide is not included in the Setup DVD-ROM, you can download it from the Web site below. An Internet connection is required for downloading.

Chapter 2 Scanning with ScandAll PRO

This chapter describes how to scan documents with the scanner using ScandAll PRO.

2.1 Selecting a Scanner Driver ................................................................. 18
2.2 Selecting a Scanner Model ................................................................. 19
2.3 Configuring Scan Settings ................................................................. 20
2.4 Scanning Methods .............................................................................. 21
2.5 Scanning Methods (Scan) ................................................................. 22
2.6 Scanning Methods (Batch Scan) ......................................................... 25
2.7 Advanced Scanning .......................................................................... 29
2.8 Useful Post-Scan Functions ............................................................. 68
2.9 Exporting and Importing Profiles ..................................................... 70
2.10 Premium Option Enabling Condition .............................................. 73
2.1 Selecting a Scanner Driver

An fi-Series color image scanner comes with the following; a TWAIN driver that conforms with the TWAIN standard, an ISIS driver that conforms with the ISIS standard, and Kofax VRS. This chapter describes the steps to scan documents with a TWAIN driver or an ISIS driver.

There is no significant difference between a TWAIN driver and an ISIS driver. Choose one to suit your requirements.

- In ScandAll PRO, [TWAIN] is selected by default.
- For functional details of the TWAIN driver, refer to the TWAIN Driver Help.
- For functional details of the ISIS driver, refer to the ISIS Driver Help.
- For information about the Kofax VRS, refer to the Kofax VRS helps.
- Kofax VRS can be used for scanners that support Kofax VRS.

The following explains how to select the scanner driver to use with ScandAll PRO.

1. Select the [Tool] menu → [Preferences].
   - The [Setup] dialog box appears.

2. On the [Scan] tab, select either of the drivers under [Device Driver].

3. Click the [OK] button to save the settings.
2.2 Selecting a Scanner Model

You need to select a scanner to use before you scan a document. The following explains how to select the scanner.

1. Select the [Scan] menu → [Select Scanner].
   ➤ The [Select Scanner] dialog box appears.

2. Select a scanner you want to use, and click the [Select] button.
   Select the scanner model that you connected to your computer.
   Note that the indication of the scanner model name depends on the selected scanner driver.

**TWAIN driver:**

**ISIS driver:**
2.3 Configuring Scan Settings

The scan settings are configured in the scanner driver's setup dialog box.

The scanner driver's setup dialog box specifications differ depending on the scanner. For details, refer to the Operator's Guide for the scanner you are using.

1. Select the [Scan] menu → [Scanner Settings].
   - The scanner driver's setup dialog box appears.

TWAIN driver:

   2. When you have completed the settings, click the [OK] button.
      - The scan settings are configured.

ISIS driver:

   For the configurable parameters in the respective drivers, refer to the Operator's Guide for the scanner you are using.
2.4 Scanning Methods

There are two ways to scan documents by using ScandAll PRO.

**Scan**

With Scan, you can perform a scan easily without configuring complicated settings. Each time you perform a scan, you can change settings as necessary, such as the file format, saving destination, and scan settings. For details, refer to "2.5 Scanning Methods (Scan)" (page 22).

**Batch Scan**

With Batch Scan, you can save various settings as a profile beforehand and then scan documents with the profile. Saving profiles means that you do not need to configure settings for every scan. You can create more than one profile beforehand, so that you can switch to the appropriate scan settings by selecting a profile for the scan. For details, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).
2.5 Scanning Methods (Scan)

With Scan, you can configure settings, such as the file format, saving destination, and scan settings as necessary. The settings on this section cannot be used for scanning with ScanSnap mode.

1. Load the document in the scanner.
   For how to load the document in the scanner, refer to the Operator’s Guide for the scanner you are using.

2. Select the [Scan] menu → [Scan Settings].
   ⇨ The [Scan Settings] dialog box appears.

3. In the [Scan Settings] dialog box, configure various settings such as for saving the scanned images.

   ![Scan Settings dialog box]

   For information about the setting items you can configure, refer to the ScandAll PRO Help.
4. Click the [Scanner Setting] button.

⇒ The scanner driver's setup dialog box appears.

**TWAIN driver:**

![TWAIN Driver Setup Dialog Box]

**ISIS driver:**

![ISIS Driver Setup Dialog Box]

5. Configure the scan settings.
   For the configurable parameters in the respective drivers, refer to the Operator's Guide for the scanner you are using.

6. When you have completed the settings, click the [OK] button.

⇒ You are returned to the [Scan Settings] dialog box.
7. Click the [Scan] button.

- Do not connect and disconnect the scanner and other USB devices during scanning.
- Do not switch users during scanning. Doing so will cancel scanning.

When using the TWAIN driver, clicking the [Scan] button may display the scanner driver's setup dialog box. If so, you can also change the settings in the dialog box displayed.

Click the [Scan] button to scan the document.
Click the [Close] button when you finish scanning.

If you do not want to display the scanner driver's setup dialog box, clear the [Show TWAIN dialog before each batch scan process] check box in the [Scan Settings] dialog box.

▷ After the document is scanned, the scanned image(s) are displayed on the ScandAll PRO window, and then saved to a file.

If you clear the [Save to file] check box in the [Scan Settings] dialog box, the scanned image(s) will no longer be saved to a file. To save the image(s) to a file, select the [File] menu → [Save As].

- To scan documents with the same settings afterwards, select the [Scan] menu → [Scan].
- For more details about the functions and operations of ScandAll PRO, refer to the ScandAll PRO Help.

For information about scanning methods other than scanning with [Scan], refer to "2.7 Advanced Scanning" (page 29).
2.6 Scanning Methods (Batch Scan)

With Batch Scan, you can save various settings as profiles beforehand and then scan documents by using such profiles.

Creating and Editing Profiles

1. Select the [Scan] menu → [Batch Scan Settings].
   ⇨ The [Batch Scan Settings] dialog box appears.

2. Do the following as necessary:
   - To create a new profile based on a default profile:
     - Click the [Add] button.
     - The default settings appear in the [Profile Editor] dialog box.
   - To create a new profile based on an existing profile:
     - Select a profile you want to change the settings for, and click the [Copy] button.
     - The profile you selected from the profile list is displayed as a new profile in the [Profile Editor] dialog box.
   - To change the settings of an existing profile:
     - Select a profile you want to change the settings for, and click the [Edit] button.
     - The selected profile appears in the [Profile Editor] dialog box.
   - To delete an existing profile from the profile list:
     - Select a profile you want to delete, and then click the [Delete] button.
     - The selected profile is deleted.
When you create a profile, the profile is added in the profile list.

1. Select the [Tool] menu → [Preferences] and specify a profile name for [Initial setting for profile] on the [Scan] tab.
2. For [Batch Scan Setting], create a profile with the same name as the one you specified.

- The profile showing [Template] at [Type] in the dialog box is a default sample profile. It cannot be used for actual scanning. Use this profile as the base of new profiles.
- When the title line of each parameter in the profile list is clicked, profiles other than [Template] are sorted.
- You can specify the default profile beforehand.
  1. Select the [Tool] menu → [Preferences] and specify a profile name for [Initial setting for profile] on the [Scan] tab.
  2. For [Batch Scan Setting], create a profile with the same name as the one you specified.

3. An asterisk (*) is displayed to the right of the created profile type. The settings of the profile are set as default.
   When you create a new profile with the [Add] button, the profile is created with the default settings values.

3. In the [Profile Editor] dialog box, configure settings for scanning and saving the scanned images.

When you use the TWAIN driver, only [00: Current Setting] is available for [Setting File] in [Detail Scanner Settings].

For information about the setting items you can configure, refer to the ScandAll PRO Help.
4. Click the [OK] button.
   ⇒ You are returned to the [Batch Scan Settings] dialog box. Added or copied profiles by using the [Add] or [Copy] button are added to the profile list.

Scanning Documents

1. Load the document in the scanner.
2. Select a profile from the [Select the Batch Profile] drop-down list on the toolbar.
3. Click the [Start Batch Scan] button.

- Do not connect and disconnect the scanner and other USB devices during scanning.

- You can perform a scan by using the [Scan] menu or by configuring settings in the [Batch Scan Settings] dialog box as well. For more information, refer to the ScandAll PRO Help.

- When a batch scan is performed, the batch scan working state is temporarily saved automatically. Because only one working state is temporarily saved for each scanning profile at a time, the saved state is always overwritten with the one last used. The temporarily saved batch scan working state can be restored from the [Scan] menu → [Restore Batch Scan]. For details on how to restore a batch scan, refer to "Restarting a Suspended Batch Scan" (page 59).

- Do not switch users during scanning. Doing so will cancel scanning.

- After the document is scanned, the scanned image(s) are displayed on the ScandAll PRO window, and then saved to a file.
● If another scan is appended, inserted, replaced, or added to the document batch, or scanned images are edited after performing a batch scan, you can save the changed contents from the [File] menu → [Save].
2.7 Advanced Scanning

ScandAll PRO allows you to scan documents by various methods. The following shows the scanning methods list.

Scanning Methods List

Changing the scanning method

- "Duplex Scanning Using the ADF Virtual Duplex Option (fi-6750S)" (page 30)

Setting post-scan operations and processes

- "Saving Scanned Image in PDF File Format" (page 32)
- "Dividing a Multipage Document Using Patch Codes" (page 34)
- "Dividing a Multipage Document Using Barcodes" (page 37)
- "Specifying the Result of Zone OCR as a File Name" (page 47)
- "Specifing the Result of Barcode Recogniton as a File Name" (page 51)
- "Saving Folders for Each Batch Scan" (page 55)
- "Saving Scanned Images from a Batch Scan to SharePoint Server" (page 57)
- "Restarting a Suspended Batch Scan" (page 59)
- "Outputting Indexing Information File and Linking with an Application" (page 61)
- "Detecting Errors in the Scanned Document (fi-6800)" (page 65)

Changing the scanner's scan responses

- "Using the Scanner Buttons to Start a Scan Quickly" (page 44)
Duplex Scanning Using the ADF Virtual Duplex Option (fi-6750S)

The ADF Virtual Duplex option allows you to scan the front of the pages of a document first, and then scan the back sides in succession. It then automatically sorts these scanned pages in the correct order.

1. Load the document face-down on the ADF paper chute. For how to load the document on the ADF paper chute, refer to the Operator's Guide for the scanner you are using.

2. In ScandAll PRO, specify Duplex Scan mode. Configure the parameter as one of the following:

   **When scanning with the Scan option**
   Select the [Perform ADF virtual duplex scanning] check box in the [Scan Settings] dialog box.

   ![Scan Settings](image)

   **When selecting the Batch Scan option**
   Display the profile to be used for scanning in the [Profile Editor] dialog box. On the [Scan] tab, select [ADF (Virtual Duplex)] from [Scan Type].

   ![Profile Editor](image)

3. Perform a scan with ScandAll PRO. When the scanning is complete, a message appears to prompt you to reload the document face-up.

![Scan Complete](image)
4. Load the document face-up on the ADF paper chute. For how to load the document on the ADF paper chute, refer to the Operator's Guide for the scanner you are using.

When scanning the back sides of the pages of a document, carefully load the document so that:
- The document is scanned from the last page.
- The pages are not upside down.

5. Click the [Yes] button.

When the scanning is complete, the pages of the scanned document are sorted automatically.

- The ADF Virtual Duplex option is not available once you have selected any of the following. To use the option, change the settings in ScandAll PRO or in the scanner driver.
  - The [Output color and monochrome simultaneously] and [Sort color and monochrome automatically] check boxes on the [File format and Name scheme] tab in the [Profile Editor] dialog box.
  - Any of the [Separate per], [Use job separator (patch code)], [Use job separator (barcode)], and [Use job separator (special paper)] check boxes on the [Document separation] tab in the [Profile Editor] dialog box.
  - The [Multi Image Output] check box in the [Multi Image] dialog box, which is opened by clicking the [Enable Multi Image] check box in the [TWAIN Driver (32)] dialog box of the TWAIN driver.
  - The [Split Image] and [Blank Page Skip] check boxes in the [Option] dialog box, which is opened by clicking the [Option] button in the [TWAIN Driver (32)] dialog box of the TWAIN driver.

- The scanned images are not sorted if the page count on the front pages differs from that on the back side.
Saving Scanned Image in PDF File Format

ScandAll PRO allows you to create PDF files easily without any special steps. By changing the compression rate, you can reduce the size of a PDF file.

ScandAll PRO is recommended for scanning in color or grayscale mode.

The procedure is as follows:

1. Load the document in the scanner.
   For how to load the document in the scanner, refer to the Operator's Guide for the scanner you are using.

2. In ScandAll PRO, select the file format to save the scanned images from the following:
   - PDF File
   - SinglePage PDF File
   - PDF/A File
   - SinglePage PDF/A File

   The password to open a PDF file cannot set for the PDF/A File format.

   ![Image showing file format options]

   A [PDF File] or [SinglePage PDF File] is saved in a format compatible with Adobe Acrobat 4.0 (PDF 1.3), while a [PDF/A File] or [SinglePage PDF/A File] is saved in a PDF/A-1b format (format for an archive of digital documents based on PDF 1.4).
   Selecting [SinglePage PDF File] or [SinglePage PDF/A File] creates one file per scanned image, and selecting [PDF File] or [PDF/A File] creates one file containing multiple scanned images.

When scanning with the Scan option
Select a file format from [File Format] in the [Scan Settings] dialog box.

When selecting the Batch Scan option
Display a profile name you want to use for scanning your file in the [Profile Editor] dialog box. Select the [File format and Name scheme] tab, and then select a file format from [File Format].
3. To configure PDF-related optional settings, click the [PDF Option] button.

- The [Output PDF file] dialog box appears.

In this dialog box, you can change the compression rate for creating a file, make searchable PDF files, and set a password to open a PDF file.

For details about the [Output PDF file] dialog box, refer to the ScandAll PRO Help.

4. Perform a scan with ScandAll PRO.

- After the document is scanned, the scanned image(s) are displayed on the ScandAll PRO window, and then saved as a PDF file.

- You can edit or view the images scanned by ScandAll PRO after the ScandAll PRO window is closed. For more information, refer to the ScandAll PRO Help.

- You can configure the settings not to display the scanned image(s) on the ScandAll PRO window when you scan documents. For more information, refer to the ScandAll PRO Help.
Dividing a Multipage Document Using Patch Codes

ScandAll PRO supports the Job Separation function using patch code sheets. This function allows you to divide scanned images of a multipage document by a specified unit without interrupting the ongoing scan, and save them respectively in separate folders. When the output file format is set to multipage PDF or TIFF, and multipage document is scanned, the pages can be divided by the specified unit and saved as separate files.

The procedure is as follows:

1. Prepare patch code sheets.
   The PDF file for use as a patch code sheet comes with four size types (A3, A4, Double Letter and Letter). Before using the patchcode-based Job Separation function, you need to select the [Start] menu → [All Programs] → [Fujitsu ScandAll PRO] → [Patch Code] → [Job Separation (A3)], [Job Separation (A4)], [Job Separation (DoubleLetter)], or [Job Separation (Letter)], and then print as many of the PDF file of the specified size type as you need.

   - Take note of the following when you print out a patch code sheet:
     - Use blank white paper.
     - Set the scaling to 100%.
       The sheet is not recognized correctly when printed in a size smaller than the original.
     - Do not save toners.
       The sheet is not recognized correctly if the print is too light.
     - Do not use thin paper in order to avoid bleed-through.
       When the prints are seen through the paper, the scanner may recognize the paper as a duplex printed paper.

2. Create a new profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).

3. Select the [Document separation] tab, and then select the [Use job separator (patch code)] check box.

   - When you copy a printed patch code sheet with a copy machine, print it with the same size and color density of the original sheet.
   - Using the same patch code sheets repeatedly may decrease the recognition accuracy due to accumulated dirt on the sheets. If the patch code sheets are not recognized correctly or get smudged, print new patch code sheets.
To not save the patch code sheet images, select the [Remove job separator] check box.
In Duplex Scan mode, you can disable the save of images on the back of the patch code sheet by selecting the [Remove next page of job separator] check box.

4. Insert the patch code sheets wherever you want the file/folder to separate.
   Load the document with the patchcode-printed sheets face-down on the ADF paper chute.

5. Specify the created profile and perform a batch scan.
   For how to perform a batch scan, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).

Follow the procedure below to save images of a scanned document that are separated by patch code sheets, in separate folders.
This section explains how to set [Document Counter] to saving folder names, and [Character string 1] and [Page Counter] to scanned document file names.

1. Select the [Use the Name Rule] check box on the [File format and Name scheme] tab in the [Profile Editor] dialog box, and click the [Name Rule] button.
   The [Name Rule] dialog box appears.

2. Set [Document Counter], [Folder delimiters], [Character string 1], and [Page Counter] in [Settings applied].

   Items set above [Folder delimiters] are used for the saving folder names.
   In this example, [Document Counter] is used for the folder names, and the scanned images are saved in these folder.
   Saving example:
If [Folder delimiters] is not set, no folders are created, and [Document Counter], [Character string 1], and [Page Counter] will be the file name. Saving example:

<table>
<thead>
<tr>
<th>Folder names</th>
<th>Saving Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001image0001.jpg</td>
<td>0001image0002.jpg</td>
</tr>
<tr>
<td>0002image0001.jpg</td>
<td>0002image0002.jpg</td>
</tr>
<tr>
<td>0003image0001.jpg</td>
<td>0003image0002.jpg</td>
</tr>
</tbody>
</table>

When not specifying [Document Counter] as folder names

Saving Folder

0001image0001.jpg
0001image0002.jpg
0002image0001.jpg
0002image0002.jpg
0003image0001.jpg
0003image0002.jpg
Dividing a Multipage Document Using Barcodes

ScandAll PRO supports the Job Separation function using barcode-printed sheets. This function allows you to divide scanned images of a multipage document by a specified unit without interrupting the ongoing scan, and save them respectively in separate folders. When the output file format is set to multipage PDF or TIFF, and multipage document is scanned, the pages can be divided by the specified unit and saved as separate files. You can create files and folders with a name that includes the document counter or the text recognized from a barcode.

ScandAll PRO can detect the following types of barcodes:

### One-dimensional Barcodes

<table>
<thead>
<tr>
<th>Code</th>
<th>Character set</th>
<th>Field width</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPC/EAN/</td>
<td>Numbers</td>
<td>UPC:12 (UPC-A only; includes check digits)</td>
</tr>
<tr>
<td>JAN</td>
<td></td>
<td>EAN, JAN: 8 or 13 (includes check digits)</td>
</tr>
<tr>
<td>CODE39</td>
<td>ASCII data</td>
<td>1 to 32 (excludes start/stop codes)</td>
</tr>
<tr>
<td>(*1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CODE128/EAN128</td>
<td>ASCII data</td>
<td>1 to 32 (excludes check characters)</td>
</tr>
<tr>
<td>Codabar (NW7)</td>
<td>4 start/stop characters, numbers, 6 symbols</td>
<td>1 to 32 (excludes start/stop codes)</td>
</tr>
<tr>
<td>ITF</td>
<td>Numbers</td>
<td>2 to 32 (always even number of digits)</td>
</tr>
</tbody>
</table>

*1: Operates in Full ASCII mode.

### Two-dimensional Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Character set</th>
<th>Field width</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF417</td>
<td>ASCII data, Binary data (multibyte characters)</td>
<td>Alphanumeric mix: Up to 1850 characters</td>
</tr>
<tr>
<td></td>
<td>Mixture of the types of data above</td>
<td>Numbers: Up to 2710 digits</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Binary data: Up to 1108 bytes</td>
</tr>
<tr>
<td>QR code</td>
<td>Numbers, alphabetical characters, symbols, multibyte characters, control codes</td>
<td>Alphanumeric mix: Up to 395 characters</td>
</tr>
<tr>
<td></td>
<td>Mixture of the types of data above</td>
<td>Numbers: Up to 652 digits</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Kanji, full-width Kana (Japanese): Up to 167 characters</td>
</tr>
</tbody>
</table>

For details on the parameters for one-dimensional barcodes detection, refer to "One-dimensional Barcode Detection Parameters" (page 38).

Examples of Two-dimensional Code

<table>
<thead>
<tr>
<th>PDF417</th>
<th>QR code</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="PDF417 Example" /></td>
<td><img src="image" alt="QR Code Example" /></td>
</tr>
</tbody>
</table>
For details on the parameters for PDF417 detection, refer to "PDF417 Detection Parameters" (page 39).

For details on the parameters for QR code detection, refer to "QR Code Detection Parameters" (page 39).

However, divided QR codes cannot be scanned.

The following lists the barcode detection parameters:

### One-dimensional Barcode Detection Parameters

<table>
<thead>
<tr>
<th>Menu option</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcode height</td>
<td>10 to 30 mm / 0.39 to 1.18 in.</td>
</tr>
<tr>
<td>Barcode width</td>
<td>300 mm / 11.81 in. or less</td>
</tr>
<tr>
<td>Barcode margin</td>
<td>5 mm / 0.20 in. or more on each side of barcode</td>
</tr>
<tr>
<td></td>
<td>(The left and right edges of ITF are either 5 mm / 0.20 in. or more, or six times the width of the thin element or more, whichever is larger)</td>
</tr>
<tr>
<td>Barcode color</td>
<td>Black</td>
</tr>
<tr>
<td>Barcode base color</td>
<td>White</td>
</tr>
<tr>
<td>Resolution</td>
<td>200 to 600 dpi</td>
</tr>
<tr>
<td>Barcode angle</td>
<td>Horizontal and vertical</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu option</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thin element width/module width</td>
<td>• UPC/EAN/JAN</td>
</tr>
<tr>
<td></td>
<td>For 300 dpi or more: 0.264 mm / 0.010 in. or more</td>
</tr>
<tr>
<td></td>
<td>For less than 300 dpi: 0.30 mm / 0.012 in. or more</td>
</tr>
<tr>
<td></td>
<td>• CODE39/CODE128/EAN128/Codabar(NW7)</td>
</tr>
<tr>
<td></td>
<td>For 300 dpi or more: 0.20 mm / 0.008 in. or more</td>
</tr>
<tr>
<td></td>
<td>For less than 300 dpi: 0.30 mm / 0.012 in. or more</td>
</tr>
<tr>
<td></td>
<td>• ITF</td>
</tr>
<tr>
<td></td>
<td>For 300 dpi or more: 0.254 mm / 0.010 in. or more</td>
</tr>
<tr>
<td></td>
<td>For less than 300 dpi: 0.30 mm / 0.012 in. or more</td>
</tr>
<tr>
<td>Wide element width</td>
<td>14.0 mm / 0.55 in. or less</td>
</tr>
<tr>
<td></td>
<td>(For UPC/EAN/JAN/CODE128/EAN128, this is the width of the widest element, which is equivalent to the total width of four modules.)</td>
</tr>
<tr>
<td>Gap between characters</td>
<td>• UPC/EAN/JAN/CODE128/EAN128/ITF</td>
</tr>
<tr>
<td></td>
<td>No gap between characters</td>
</tr>
<tr>
<td></td>
<td>• CODE39/Codabar(NW7)</td>
</tr>
<tr>
<td></td>
<td>Equal to or less than either 1.52 mm / 0.06 in. or three times the width of the thin element, whichever is larger, and equal to or larger than the thin element width</td>
</tr>
</tbody>
</table>
### PDF417 Detection Parameters

<table>
<thead>
<tr>
<th>Menu option</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module width</td>
<td>0.3 to 2.0 mm / 0.01 to 0.08 in.</td>
</tr>
<tr>
<td>Module height</td>
<td>The recommended module height is three times of module length or more (When the module height is less than two times of the module width, the module can not be recognized.)</td>
</tr>
<tr>
<td>Barcode width (overall width)</td>
<td>25.5 to 170.0 mm / 1.00 to 6.69 in.</td>
</tr>
<tr>
<td>Barcode height</td>
<td>10.0 to 30.0 mm / 0.39 to 1.18 in.</td>
</tr>
<tr>
<td>Barcode margin</td>
<td>5 mm / 0.20 in. or more on each side of barcode</td>
</tr>
<tr>
<td>Barcode color</td>
<td>Black</td>
</tr>
<tr>
<td>Barcode base color</td>
<td>White</td>
</tr>
<tr>
<td>Resolution</td>
<td>200 to 600 dpi</td>
</tr>
<tr>
<td>Barcode angle</td>
<td>Horizontal and vertical</td>
</tr>
<tr>
<td>Error correction level</td>
<td>0/2/3/4/5/6/7</td>
</tr>
</tbody>
</table>

### QR Code Detection Parameters

<table>
<thead>
<tr>
<th>Menu option</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Model 2</td>
</tr>
<tr>
<td></td>
<td>ECI and FNC1 modes are not supported</td>
</tr>
<tr>
<td>Version</td>
<td>3 to 10</td>
</tr>
</tbody>
</table>

- When the barcode does not meet the combination of the parameters, it may not be recognized correctly.
- If there are multiple barcodes in the barcode detecting area, the one recognized first will be enabled.
- Two-dimensional codes can be used only when the Premium option is enabled. For details on how to enable the Premium option, refer to "2.10 Premium Option Enabling Condition" (page 73).
- If you scan a document with an undefined barcode type for this function, the document may be separated wrongly, and the scanned images may also be deleted depending on the scan settings. It is recommended to limit the types or the area of barcodes to be detected.
- Using the same sheet repeatedly may decrease the recognition accuracy due to accumulated dirt on the sheets. If the sheet is not recognized correctly or gets smudged, replace it with a new sheet.
If the barcode sheets are not recognized correctly or get smudged, print new barcode sheets. If the text recognized from the barcode includes any control characters and/or characters unavailable for a file or folder name, such as \/:*?"<>|, those are replaced with " " (space) or "_" (underscore) in the created folder or file name. Some control characters are ignored.

The barcode may not be recognized correctly depending on the document (if skewed), the scanner driver settings and/or the print status of barcodes. Operate after ensuring that the barcode is correctly recognized.

The procedure is as follows:
The example case shows how to limit the area to detect the barcode to scan documents.

1. Scan a sample image for barcode recognition.
   For how to perform a scan, refer to "2.5 Scanning Methods (Scan)" (page 22) or "2.6 Scanning Methods (Batch Scan)" (page 25).

2. Create a new profile in ScandAll PRO, and then open the [Profile Editor] dialog box.
   For how to create profiles, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).

<table>
<thead>
<tr>
<th>File format</th>
<th>Image type</th>
<th>Paper size</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP</td>
<td>Monochrome 8-bit Gray 24-bit Color</td>
<td>Height and width: 50 to 453 mm</td>
<td>200 dpi or higher</td>
</tr>
<tr>
<td>JPEG (*1)</td>
<td>8-bit Gray 24-bit Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIFF (*2)</td>
<td>Monochrome 8-bit Gray 24-bit Color</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: Progressive JPEG is not included.
*2: For Multipage TIFF, the first page displayed is the sample image.
3. Select the [Document separation] tab, and then select the [Use job separator (barcode)] check box.

4. Click the [Setup] button.
   - The [Barcode Setting] dialog box appears.

   - To not save the image of the barcode-printed sheet, select the [Remove job separator] check box.
   - In Duplex Scan mode, you can disable the save of the image on the back of the barcode-printed sheets by selecting the [Remove next page of job separator] check box.

5. Click and drag to select the area to detect the barcode.
   - The selected area is displayed in shaded red.

   - Sample image display
     The [Barcode Setting] dialog box displays an image which has been displayed once and then saved. If no relevant image is saved, the image currently displayed on the main window is used as a sample image. However, an image is not displayed on the conditions below.
     - There is no image on the main window
     - An image on the main window does not meet the condition as a sample image.
     If there is no image displayed or if you want to change the sample image to be shown, select the [File] menu → [Open] to select a sample image.
● Barcode properties
You can specify advanced settings for barcode recognition from the [Barcode] menu → [Advanced] ("Two-dimensional code" can be selected when the Premium option is enabled). For information about the setting items you can configure, refer to the ScandAll PRO Help.

If the barcode scanning speed decreases, limit the barcode types to be detected or narrow the barcode area to improve the scanning speed.

● Barcode recognition results
You can check the barcode recognition results of the sample image from the [Barcode] menu → [Recognize Barcode]. This section explains the [Barcode recognition results] dialog box when the Premium option is enabled.

6. After you have completed the area selection, select the [File] menu → [Exit] to save the setting contents.

7. Insert the barcode-printed sheets wherever you want the file/folder to separate.
Load the document with the barcode-printed sheets face-down on the ADF paper chute.

8. Specify the created profile and perform a batch scan.
For how to perform a batch scan, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).
Follow the procedure below to save images of a scanned document that are separated by barcode-printed sheets, in separate folders, and name each folder with a character string recognized from the relevant barcode:

This section explains how to set [Separator] to saving folder names, and [Character string 1] and [Page Counter] to scanned document file names as an example.

1. Select the [Use the Name Rule] check box on the [File format and Name scheme] tab in the [Profile Editor] dialog box, and click the [Name Rule] button. The [Name Rule] dialog box appears.

2. Set [Separator], [Folder delimiters], [Character string 1], and [Page Counter] in [Settings applied].

   [Separator] situated above [Folder delimiters] is the folder name, and the scanned images are saved in this folder.

   Saving example:

   ![Image example]

If [Folder delimiters] is not set, no folders are created, and [Separator], [Character string 1], and [Page Counter] will be the file name.

   Saving example:

   ![Image example]
Using the Scanner Buttons to Start a Scan Quickly

You can perform a scan simply by pressing the [Scan] or [Send to] button on the scanner. To do this, you first need to assign your desired scanning applications to these buttons.

Computer Settings

1. Confirm that the scanner is connected properly to your computer, then power on the scanner. For how to connect the scanner to your computer, refer to the Operator’s Guide for the scanner you are using.

2. Select the [Start] menu → [Control Panel].
   ➔ The [Control Panel] window appears.

3. Select the [Hardware and Sound] icon.
   ➔ The [Hardware and Sound] window appears.

4. Select the [Scanners and Cameras] icon.
   ➔ The [Scanners and Cameras] window appears.

5. Display the properties of the scanner. Double-click the scanner icon.

6. Select the [Events] tab, and then select the event. From the [Select an event] menu, select the event that you want to launch an application for.

   The following events can be selected:
   - Scan Button (when the [Scan] button is pressed)
   - Send to 1 to n (when the [Send to] button is pressed while a number (from 1 to n) is displayed on the operation panel)

   Numbers displayed on the operation panel depend on the selected scanner.
   Example: Send to 1 - 9
7. Select the application to be launched when an event occurs. Select the [Start this program] option button under [Actions], and then select the application you want to use.

8. Click the [OK] button.

- This completes the computer settings for an application other than ScandAll PRO. Then, configure settings for your scanner according to "Scanner Settings" (page 46).
- The windows that appear and the operations differ by the operating system that you are using.

9. Start ScandAll PRO.

10. Select the [Tool] menu → [Preferences].

   - The [Setup] dialog box appears.


12. Select the action for the event you selected in Step 6 (page 44), and then select a profile from the list you want to use for scanning.

   - If you want to link with other buttons here, repeat Steps 6 (page 44) to 7 (page 45), and finally perform Step 8 (page 45).

You need to create the required profile beforehand. For how to create profiles, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).
13. Click the [OK] button.

14. Exit ScandAll PRO.

Scanner Settings

1. Configure the buttons on the scanner.

   Example of ADF type
   ![Example of ADF type]

   Example of Flatbed type
   ![Example of Flatbed type]

   - When using the [Scan] button
     No setting changes are needed.

   - When using the [Send to] button
     1. Press the [Function] button to change the number displayed on the operation panel.
     2. Match the event set at the computer (Send to 1 to n) and the number.

     To perform the event configured with [Send to 2], for example, display [2] on the operation panel.

2. Press the configured button on the scanner.

   - A batch scan is executed according to the selected profile's settings.

   ![Warning]
   Depending on the scanner you are using, the profile name specified as [Send to 1 to n] in Step 12 (page 45) is displayed on the operation panel. However, the profile name is not displayed correctly if...
   - the name is set in a language that the scanner does not support (Unsupported languages are displayed with ■)
   - the name does not fit into the display range (16 characters × 3 rows)

   ![Tip]
   Operation panel specifications differ depending on the scanner.
   For details, refer to the Operator’s Guide for the scanner you are using.
Specifying the Result of Zone OCR as a File Name

ScandAll PRO supports the Zone OCR function. With this function, you can perform Zone OCR on a specified area of a scanned document and output the recognition result to an indexing information file. You can also use character strings recognized by the Zone OCR as an image file or folder name. This section explains how to set the character strings recognized by Zone OCR as a file name.

The following resolutions are recommended for images. Resolution higher than 600 dpi cannot be recognized for Color/Gray.

- Monochrome: 400/600 dpi
- Color/Gray: 200/300 dpi

The deskew function of the driver and the orientation correction filter may improve the recognition rate.

The following table shows the file formats, image types, paper sizes, and resolutions for Zone OCR:

<table>
<thead>
<tr>
<th>File format</th>
<th>Image type</th>
<th>Paper size</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP</td>
<td>Monochrome 8-bit Gray 24-bit Color</td>
<td>Height and width: 50 to 453 mm</td>
<td>200 dpi or higher</td>
</tr>
<tr>
<td>JPEG (*1)</td>
<td>8-bit Gray 24-bit Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIFF (*2)</td>
<td>Monochrome 8-bit Gray 24-bit Color</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- *1: Progressive JPEG is not included.
- *2: For Multipage TIFF, the first page displayed is the sample image.

The procedure is as follows:
The example case shows how to set [Character string 1], [Page Counter], and the Zone OCR results to file names.

1. Scan a sample image for Zone OCR.
   For how to perform a scan, refer to "2.5 Scanning Methods (Scan)" (page 22) or "2.6 Scanning Methods (Batch Scan)" (page 25).

   The image created with ScandAll PRO can be used for samples. Details of the conditions are as follows:

2. Create a new profile in ScandAll PRO, and then open the [Profile Editor] dialog box.
   For how to create profiles, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).
3. Select the [Filter] tab, and then select the [Enable Zone OCR] check box.

4. Click the [Setup] button.
   - The [Zone OCR Settings] dialog box appears.

5. Click and drag to select an area for Zone OCR.
   - The selected area is displayed in shaded red.

- Sample image display
  The [Zone OCR Settings] dialog box displays an image which has been displayed once and then saved. If no relevant image is saved, the image currently displayed on the main window is used as a sample image. However, an image is not displayed on the conditions below.
  - There is no image on the main window
  - An image on the main window does not meet the condition as a sample image.
  If there is no image displayed or if you want to change the sample image to be shown, select the [File] menu → [Open] to select a sample image.
### How to Use This Manual

**Introduction**

1. **Zone OCR advanced settings**
   You can specify advanced settings for Zone OCR from the [Zone OCR] menu → [Advanced]. For information about the setting items you can configure, refer to the ScandAll PRO Help.

2. **Zone OCR results**
   You can check the sample image Zone OCR result from the [Zone OCR] menu → [Zone OCR].

6. After you have completed the area selection, select the [File] menu → [Exit] to save the setting contents.

7. Click the [Name Rule] button on the [File format and Name scheme] tab in the [Profile Editor] dialog box.
   - The [Name Rule] dialog box appears.

8. Set [Character string 1], [Page Counter], and [Zone OCR] in [Settings applied].

   ![Name Rule settings](image)

   - [Character string 1], [Page Counter], and the Zone OCR result are used for the file name.

   ![Character string example](image)

   Note the following when using the character strings recognized by Zone OCR as a file name.

   - Up to 32 characters can be recognized.
   - Illegal characters (\ / ? * " < > |) are replaced with "(space) or "_" (underscore).
   - If there are several lines, line feed characters are deleted.
   - If outputting the single page type file, include [Page Counter] to the file name. If the page counter is not included, the file name may be duplicated.
   - When multipage type files are created, the character string recognized at the Zone OCR on the top page will be used for the file name.

9. Load the document in the scanner.
10. Specify the created profile and perform a batch scan. For how to perform a batch scan, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).

**Confirm and correct zone OCR results**

When the [Confirm and correct zone OCRed text] check box is selected on the [Zone OCR Advanced Settings] dialog box, the [Zone OCRed Text Confirmation and Correction] dialog box is displayed when a batch scan is performed. You can confirm and correct zone OCR results in this dialog box.
Specifying the Result of Barcode Recognition as a File Name

ScandAll PRO supports the barcode recognition function. With this function, you can perform barcode recognition on a specified area of a scanned document and output the recognition results to an indexing information file. You can also use character strings recognized with barcode recognition as an image file name or folder name. In addition, you can save images into separate files by using barcode-printed sheets as separators. When you do so, you can also set the recognition result of the barcode printed on the sheet as a file name. For details, refer to "Dividing a Multipage Document Using Barcodes" (page 37).

The recommended resolution for an image to be used for barcode recognition is 200 to 600 dpi.

<table>
<thead>
<tr>
<th>File format</th>
<th>Image type</th>
<th>Paper size</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP</td>
<td>Monochrome 8-bit Gray 24-bit Color</td>
<td>Height and width: 50 to 453 mm</td>
<td>200 dpi or higher</td>
</tr>
<tr>
<td>JPEG (*1)</td>
<td>8-bit Gray 24-bit Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIFF (*2)</td>
<td>Monochrome 8-bit Gray 24-bit Color</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: Progressive JPEG is not included.
*2: For Multipage TIFF, the first page displayed is the sample image.

The procedure is as follows:
The example case shows how to limit the area to detect the barcode and how to set [Character string 1], [Page Counter], and the barcode recognition result as file names to scan documents.

1. Scan a sample image for barcode recognition.
   For how to perform a scan, refer to "2.5 Scanning Methods (Scan)" (page 22) or "2.6 Scanning Methods (Batch Scan)" (page 25).

   The image created with ScandAll PRO can be used for samples.
   Details of the conditions are as follows:

2. Create a new profile in ScandAll PRO, and then open the [Profile Editor] dialog box.
   For how to create profiles, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).
3. Select the [Filter] tab, and then select the [Perform barcode recognition] check box.

4. Click the [Setup] button.
   ➤ The [Barcode Setting] dialog box appears.

5. Click and drag to select an area for barcode recognition.
   ➤ The selected area is displayed in shaded red.

- Sample image display
  The [Barcode Setting] dialog box displays an image which has been displayed once and then saved. If no relevant image is saved, the image currently displayed on the main window is used as a sample image. However, an image is not displayed on the conditions below.
  - There is no image on the main window
  - An image on the main window does not meet the condition as a sample image.
  If there is no image displayed or if you want to change the sample image to be shown, select the [File] menu → [Open] to select a sample image.
● Barcode properties
You can specify advanced settings for barcode recognition from the [Barcode] menu → [Advanced] (“Two-dimensional code” can be selected when the Premium option is enabled). For information about the setting items you can configure, refer to the ScandAll PRO Help.

![Barcode Properties dialog box](image)

6. After you have completed the area selection, select the [File] menu → [Exit] to save the setting contents.

7. Click the [Name Rule] button on the [File format and Name scheme] tab in the [Profile Editor] dialog box.

   ➤ The [Name Rule] dialog box appears.

8. Set [Character string 1], [Page Counter], and [Barcode] in [Settings applied].

   ➤ [Character string 1], [Page Counter], and the barcode recognition results are used for the file name.

- Barcode recognition results
You can check the barcode recognition results of the sample image from the [Barcode] menu → [Recognize Barcode]. This section explains the [Barcode recognition results] dialog box when the Premium option is enabled.
Note the following when using the character strings recognized with barcode recognition as a file name.

- Up to 32 characters can be recognized.
- If the barcode sheets are not recognized correctly or get smudged, print new barcode sheets. If the text recognized from the barcode includes any control characters and/or characters unavailable for a file or folder name, such as \/*?<>], those are replaced with " " (space) or "_" (underscore) in the created folder or file name. Some control characters are ignored.
- If outputting the single page type file, include [Page Counter] to the file name. If the page counter is not included, the file name may be duplicated.
- When multipage type files are created, the character string recognized with the barcode recognition on the top page will be used for the file name.

9. Load the document in the scanner.

10. Specify the created profile and perform a batch scan. For how to perform a batch scan, refer to “2.6 Scanning Methods (Batch Scan)” (page 25).
Saving Folders for Each Batch Scan

When the same profiles are used consecutively, multiple files with the same file name are created and may overwrite the previous batch scan output file. With ScandAll PRO, in order not to overwrite the file, you can make a setting to create folders for saving image files each time a batch scan is executed.

The procedure is as follows:

1. Create a new profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).

2. Select the [File format and Name scheme] tab, and then select the [Use a batch folder] check box.

3. Load the document in the scanner.

4. Specify the created profile and perform a batch scan. When the batch scan is executed, the [Batch Folder Name] dialog box appears.

For how to perform a batch scan, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).
5. Enter a batch folder name, and click the [OK] button.

![Batch Folder Name dialog box]

The batch scan starts and the scanned image file is saved in the created folder with the specified name.

To ensure the correct creation of batch folders:

- If the names of the batch folders include a number of 8 or less digits at the end, names are created by adding "1" to the previously specified number. In the case where adding "1" would increase the number of digits, the number returns to "1" instead.
- If folder names include a number of more than 8 digits at the end, the number does not vary.

### Specified batch folder name | Next batch folder name
--- | ---
Batch_0009 | Batch_0010
Batch_9999 | Batch_0001
Batch_00000001 | Batch_00000001

**Saving example:**

When using folders created for each batch scan:

- **Batch_0001**
  - image0001.jpg
  - image0002.jpg
- **Batch_0002**
  - image0001.jpg
  - image0002.jpg
- **Batch_0003**
  - image0001.jpg
  - image0002.jpg
Saving Scanned Images from a Batch Scan to SharePoint Server

With ScandAll PRO, you can perform a batch scan and save the scanned image to SharePoint Server.

The server on which SharePoint Server is running requires some ScandAll PRO modules to be installed. In order to install the modules in a server, obtain "ScandAllPROSrv.exe" from the "\ScandAll\ScandAll" folder in the Setup DVD-ROM, and execute it on the server.

The procedure is as follows:

1. Create a new profile in ScandAll PRO, and then open the [Profile Editor] dialog box.
   For how to create profiles, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).

2. Click the [Linking] tab, and select the [Link up with the following process] check box.

3. Select [Upload to SharePoint Server] and click the [Setup] button.

   ![Profile Editor](image)

   ↪ The [Information to transfer to the SharePoint Server] dialog box appears.

4. Specify the settings for saving the scanned images to SharePoint Server.

5. Click the [OK] button.
   ↪ This returns to the [Profile Editor] dialog box.

7. Specify the created profile and perform a batch scan.
   ✷ When the batch scan is executed, the image is saved in SharePoint Server.
   
   For more information, refer to the ScandAll PRO Help.
Restarting a Suspended Batch Scan

With ScandAll PRO, when a "batch scan" is performed, the batch scan working state is temporarily saved automatically. You can restart the scanning by restoring the temporarily saved batch scan working state. For example, you can continue the interrupted batch scan the next day. Similarly, if another more urgent scan needs to be performed while a batch scan is running, its working state can be saved, allowing it to be restarted at a later time.

Perform a batch scan (Automatically saved)

Perform another scan

Restore temporary saved batch scan working state to restart the batch scan

The procedure to restore the saved batch scan working state is as follows:

1. Select the [Scan] menu → [Restore Batch Scan].

   ➔ The [Saved batch scan data list] dialog box appears.
2. Select a batch scan you want to restore, and click the [Restore] button.

![Saved batch scan data list]

- The working status of the selected batch scan is restored on the main window. You can perform additional operations for the batch scan, such as additional scanning or image editing.

For more information, refer to the ScandAll PRO Help.
Outputting Indexing Information File and Linking with an Application

With ScandAll PRO, you can output the result of Zone OCR and the barcode recognition result to the indexing information file. Other items such as the image file name (full path) and the page number in the document are also output to the indexing information file. You can link with another application by specifying the name of the indexing information file name as a parameter. This function allows you to create a profile, such as for saving image data with indexing information in the server.

The procedure is as follows:

1. Create a new profile in ScandAll PRO, and then open the [Profile Editor] dialog box.
   For how to create profiles, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).

2. Set the barcode or Zone OCR in the [Profile Editor] dialog box.
   ● For details on how to set a barcode, refer to "Dividing a Multipage Document Using Barcodes" (page 37) or "Specifying the Result of Barcode Recognition as a File Name" (page 51).
   ● For details on how to set Zone OCR, refer to "Specifying the Result of Zone OCR as a File Name" (page 47).

3. In the [Profile Editor] dialog box, select the [Linking] tab, and then select the [Output indexing information] check box.
4. Click the [Set Indexing Info] button.
   ⇒ The [Set Indexing Info] dialog box appears.

This section explains the [Set Indexing Info] dialog box when the Premium option is enabled. For details about the dialog box when the Premium option is disabled, refer to the ScandAll PRO Help.

5. Specify the name and type of the file to be output.

The following settings are available only when the Premium option is enabled.
- Delimiter
- Output per job
- Output format
- Character string

6. Click the [OK] button.
   ⇒ This returns to the [Profile Editor] dialog box.

For details on how to enable the Premium option, refer to "2.10 Premium Option Enabling Condition" (page 73).

- Indexing information files are saved in the folder specified with [Folder Name] in the [File format and Name scheme] tab, in the [Profile Editor] dialog box. When the [Use a batch folder] check box is selected, indexing information files are output to the batch folder.
- Indexing information files are of the following types. The examples below are default output items. For information about the details of file types, refer to the ScandAll PRO Help.
  - Unicode Text format
    
    YYYY/MM/DD hh:mm:ss [TAB] File name (full path)
    [TAB] Current page number in document batch [TAB]
    "Zone OCR results" [TAB] "Barcode recognition results"

  - CSV format

    "YYYY/MM/DD hh:mm:ss", "File name (full path)
    "Current page number in document batch", "Zone OCR results", "Barcode recognition results"
XML format

<?xml version = "1.0" encoding = "utf-8"?>
<root>
<page>
  <item name = "Date&Time" value = "Date and Time">
    <item name = "Full Path" value = "File name (full path)"/>
  </item>
  <item name = "Page Number in Document" value = "Current page number in document batch"/>
  <item name = "Zone OCR" value = "Zone OCR results"/>
  <item name = "Barcode" value = "Barcode recognition results"/>
</page>
<page>
  <item name = "Date&Time" value = "Date and Time">
    <item name = "Full Path" value = "File name (full path)"/>
  </item>
  <item name = "Page Number in Document" value = "Current page number in document batch"/>
  <item name = "Zone OCR" value = "Zone OCR results"/>
  <item name = "Barcode" value = "Barcode recognition results"/>
</page>
</root>

7. Select the [Link up with the following process] check box on the [Linking] tab.

8. Select the [Launch another application] option button, and click the [Setup] button.

⇒ The [Option] dialog box appears.
9. Specify the settings on the dialog box.
   [Application Program]: The application to be launched
   [Argument-Parameter]: %i

   ![Option dialog box]

10. Click the [OK] button.
    ⇨ This returns to the [Profile Editor] dialog box.

11. Load the document in the scanner.

12. Specify the created profile and perform a batch scan.
    ⇨ After the document is scanned, ScandAll PRO launches the
       application and passes the indexing information file name to
       the application as a parameter.

For how to perform a batch scan, refer to "2.6 Scanning
Methods (Batch Scan)" (page 25).
Detecting Errors in the Scanned Document (fi-6800)

If an error is detected in the scanned document, the background color of the thumbnail changes automatically so that the user can recognize the target image easily.

The procedure to set the automatic error detection and notification is as follows:

1. Create a new profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to "2.6 Scanning Methods (Batch Scan)" (page 25).

2. On the [Scan] tab, select the [Mark pages when error is detected by Automatic Image Quality Checker] and [Mark pages when multifeed is detected] check boxes, and click the [OK] button.

- When selecting the [Mark pages when error is detected by Automatic Image Quality Checker] check box
  The scanned document is checked for any folds or tears. If an error is detected, it is indicated by changing the background of the thumbnail for the page containing the error to yellow.

- When selecting the [Mark pages when multifeed is detected] check box
  The scanned document is checked for any errors where multiple pages are fed at a time or where sheets of different lengths are fed. If a multifeed error is detected while scanning, the scan is continued without stopping. After all scans are completed, the multifeed error is indicated by changing the background of the thumbnail for the page containing the error to red.
3. Click the [Detail Scanner Settings] button on the [Scan] tab to configure the scan settings.
   - When selecting the [Mark pages when error is detected by Automatic Image Quality Checker] check box:

<table>
<thead>
<tr>
<th>Scanner driver</th>
<th>Settings</th>
</tr>
</thead>
</table>
| ISIS driver    | Configure the parameter as either of the following:
   - Select [Automatic], [Deskew], or [Long Page] for [Cropping] on the [Main] tab.

- When selecting the [Mark pages when multifeed is detected] check box:

<table>
<thead>
<tr>
<th>Scanner driver</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>TWAIN driver</td>
<td>On the [Job/Cache] tab in the [Option] dialog box displayed by clicking the [Option] button, select [Check Overlapping (Ultrasonic)], [Check Length], or [Check Overlapping and Length] for [Multifeed Detection].</td>
</tr>
</tbody>
</table>

4. When you have completed the settings, click the [OK] button.
   ⇨ This returns to the [Profile Editor] dialog box.

5. Click the [OK] button in the [Profile Editor] dialog box to add the profile.


7. Specify the created profile and perform a batch scan.
   ⇨ If there is an error in the scanned document, the target thumbnail is displayed with background of a different color.

Depending on the color or shape of the document, errors may be detected by mistake or fail to be recognized, since they are detected only in the corners of the scanned image. Make sure to check the scanned image yourself even when you use this detection function.
You can replace a scanned image with an error by selecting the [Page] menu → [Replace] → [Scan].
2.8 Useful Post-Scan Functions

Marking Thumbnails

This function is useful to distinguish a certain desired image from others.

The procedure is as follows:

1. Load the document in the scanner and perform a scan.
2. Select the thumbnail of the desired image, and then select the [Mark] menu → [Mark].
   - The background of the selected thumbnail turns to orange.

3. After marking the desired image, select an option from the following:

<table>
<thead>
<tr>
<th>Menu option</th>
<th>Used to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous Marked Page</td>
<td>Display the previous marked page.</td>
</tr>
<tr>
<td>Next Marked Page</td>
<td>Display the next marked page.</td>
</tr>
<tr>
<td>First Marked Page</td>
<td>Display the first marked page.</td>
</tr>
<tr>
<td>Last Marked Page</td>
<td>Display the last marked page.</td>
</tr>
<tr>
<td>Unmark</td>
<td>Unmark the selected thumbnail.</td>
</tr>
<tr>
<td>Unmark All</td>
<td>Unmark all thumbnails.</td>
</tr>
</tbody>
</table>

You can also unmark a thumbnail by right-clicking and selecting [Unmark Selected Pages] while the thumbnail is selected.
Saving Scanned Images to SharePoint

You can save scanned images to SharePoint.

Scan to Microsoft SharePoint needs to be installed. You can install Scan to Microsoft SharePoint at the same time you install ScandAll PRO. If Scan to Microsoft SharePoint is not installed, start the ScandAll PRO installer and select the option to install Scan to Microsoft SharePoint.

The procedure is as follows:

1. Load the document in the scanner and perform a scan.

2. Select the [File] menu → [Send] → [Microsoft SharePoint].

   The [Scan to Microsoft SharePoint] dialog box appears.

3. Save the scanned images to SharePoint.

   For more information, refer to Scan to Microsoft SharePoint User Guide.

   You can view Scan to Microsoft SharePoint User Guide by selecting the [Start] menu → [All Programs] → [KnowledgeLake] → [Scan to Microsoft SharePoint User Guide].
2.9 Exporting and Importing Profiles

ScandAll PRO supports the export and import of profiles. "Profiles" here include batch scan settings (profiles) and other settings (connected driver settings and others). You can select profiles to be exported.

Profiles are exported and imported in the following steps.

1. Export the ScandAll PRO profiles by using the export function.
2. Import the exported profiles into ScandAll PRO into another computer by using the import function.

Exporting Profiles

Export ScandAll PRO profiles into an export file (.cab).

The procedure is as follows:

1. Select the [Start] menu → [All Programs] → [Fujitsu ScandAll PRO] → [Tools] → [Profile Exporter].
   - The [Profile Exporter] dialog box appears, and profiles registered in ScandAll PRO are shown in the profile list.
2. Select the check boxes of the profiles to be exported.
3. Click the [Run] button.
   - The [Save As] dialog box appears.

- This function is not available when ScandAll PRO or Web Parts is running. Exit the ScandAll PRO or the Web parts, and perform this function.
- For information about Web Parts, refer to the SharePoint Help.
- ScandAll PRO profiles of the currently logged in user are exported. Other users' ScandAll PRO profiles cannot be exported.
4. Specify the directory and file name, and click the [Save] button.
   The ScandAll PRO profiles are exported, and the message of the export completion appears.

5. Click the [OK] button.

   Exported profiles can be used as a backup.

Importing Profiles

Import the profiles which were exported in "Exporting Profiles" (page 70) into another computer.

The procedure is as follows:

1. Select the [Start] menu → [All Programs] → [Fujitsu ScandAll PRO] → [Tools] → [Profile Importer].
   The [Profile Importer] dialog box appears.

2. Select the file to be imported.
   Select the file (.cab) that was exported in "Exporting Profiles" (page 70).
   To specify the file to be imported, perform one of the following:
   - Enter the path to the file.
   - Click the [Browse] button, and specify the file.
   - Specify the file by a drag and drop operation.

   The file path can be up to 255 bytes long.
3. Select the type of import. 
   You can select one of the following types of import:
   - Replace All
     All profiles currently registered in ScandAll PRO are removed, and replaced by the profiles in the import file.
   - Add
     The profiles in the import file are added to ScandAll PRO. If a profile currently registered in ScandAll PRO has the same name as a profile in the import file, you can overwrite with the profile in the import file by checking the [Overwrite profile of the same name] check box.

If select run [Add], any event set up in ScandAll PRO on the exporting side will also be set up in ScandAll PRO on the importing side. (Events can be specified in the [Event] tab in the [Setup] dialog box opened by selecting [Tool] → [Preferences].)

4. Click the [Run] button.
   - The message of the import completion appears.

5. Click the [OK] button.

When profiles have been imported, import results are created. The import results are saved in the following folder with the file name "ScandAllImpProfile.csv":
   - For Windows XP or Windows Server 2003
     C:\Documents and Settings\user name\My Documents \ScandAllPro
   - For Windows Server 2008, Windows Vista, or Windows 7
     C:\Users\user name\Documents\ScandAllPro
2.10 Premium Option Enabling Condition

Either of the following requirements must be met for the Premium option to be enabled:

- Premium Upgrade option is installed

You can check if the Premium Upgrade option is installed by the following steps:

1. Click the [Help] menu → [About ScandAll PRO].
   - The [About ScandAll PRO] dialog box appears.
2. Check the ScandAll PRO version.
   - When you find the "Premium" at the end of version number, the Premium Upgrade option is installed.

- One of the following scanners is connected to the computer in which ScandAll PRO V2.0 or later is installed:

Purchasing and installing the Setup DVD of ScandAll PRO V2 or later does not enable the Premium option. You are required to purchase the Premium Upgrade option separately.
# Index

## A
- advanced scanning ................................................... 29

## B
- batch scan .............................................................. 25

## C
- configuring scan settings ............................................ 20
- conventions ............................................................... 5
- creating and editing profiles ........................................ 25

## D
- dividing a multipage document
  - barcode ............................................................... 37
  - patch code ........................................................... 34
- driver
  - ISIS ................................................................. 18
  - TWAIN .............................................................. 18

## F
- features .................................................................. 12
  - ScandAll PRO ....................................................... 12
  - ScanSnap mode .................................................... 13

## H
- how to use this manual ................................................ 2

## I
- indexing information .................................................. 61
  - introduction ......................................................... 3

## K
- Kofax VRS .............................................................. 11

## L
- launching ................................................................ 16

## P
- premium option ........................................................ 73
  - profile .................................................................... 70

## R
- restarting batch scan ................................................. 59
  - restoring batch scan ................................................ 59

## S
- saving folder ............................................................ 55
- saving scanned image in PDF file format ....................... 32
  - [Scan] button ........................................................... 44
- scanning methods list ................................................ 29
- scanning methods .................................................... 17
  - batch scan ..........................................................., 21, 25
  - scan .............................................................. 21, 22
  - scan .............................................................. 22
  - selecting a scanner driver ........................................ 18
  - selecting a scanner model ........................................ 19
  - [Send to] button ....................................................... 44
  - SharePoint .............................................................. 69
  - SharePoint Server .................................................... 57
- specifying file name
  - barcode ............................................................... 51
  - zone OCR ............................................................ 47
- system requirements ................................................. 14

## U
- useful post-scan functions .......................................... 68
● The contents of this manual are subject to change without notice.
● PFU LIMITED assumes no liability for incidental or consequential damages arising from the use of this Product, and any claims by a third party.
● Copying of the contents of this manual, in whole or in part, as well as the scanner applications is prohibited under the copyright law.